
BURY Time Suite 
INDEX

INSTALLATION AND TYPES OF USE 2
1. General 2
2. Technical requirements 2
3. Installation of the software 2
4. First use of the BURY Time Suite program 4
5. Software update installation 5
6. Using the software in a network environment 

with multiple users 6

FIRST STEPS 8
7. Overview of menu items  8
8. Adding additional drivers 10
9. Adding vehicles  10

10. Adding destinations / contacts  12
11. Adding journey reasons  14
12. Backup / restore the database  14

CREATING A DRIVER’S LOGBOOK 15
13. Importing position data 15
14. Processing position data 19
15. Closing tours  22
16. Printing the driver’s logbook 23
17. Removing old vehicles  25
18. Device replacement  26

PRODUCT CONFIGURATION 28
19. Menu configuration 28

19.1 Factory settings 31

FURTHER INFORMATION 32
20. Service 32



2

INSTALLATION AND TYPES OF USE

1. GENERAL 

Dear Customers, we are pleased that you 
have chosen to purchase an electronic 
driver’s logbook system by BURY Sp. z o.o. 
This system, which will be installed in 
your vehicle, also includes an administra-
tion program – the BURY Time Suite – 
the operation of which is explained in 
detail below.  

Please read this user manual carefully to 
make full use of the software’s capabilities. 
For any further questions, feel free to reach 
out to your BURY distributor or our 
Information Center Hotline. You can find the 
phone numbers in the Service section. 

2. TECHNICAL 
REQUIREMENTS

Before beginning the installation of BURY 
Time Suite, please ensure that your 
computer or laptop meets the following 
requirements: 

— Processor: 
min. Intel i3-7100 or later, 
Intel i7-4770 or later recommended 

— Operating system: Microsoft Windows 
10/11 (64-bit) 

— .NET 3.5 Framework  
— Database: Firebird SQL 5.0 (Integrated 

into installation package) 
— RAM: 

min. 8 GB, 16 GB recommended 
— Hard disk drive: 

min. 10 GB of free space, 
20 GB of free space recommended 

— Screen resolution: at least 1024x768 
pixels 

— USB interface. 

3. INSTALLATION 
OF THE SOFTWARE 

Please install the BURY Time Suite 
management program on your computer 
or laptop, downloaded from the website: 
bury.com/en/products/cl-1020-time/.... 
The download files are available under the 
product description. 

Please select a language for the installation 
wizard. After selecting the language, 
installation messages will be displayed in 
the chosen language. This has no impact on 
the later language of the BURY Time Suite 
program menu. It can be set separately later. 

Please review the license agreement. 
If you accept it, you may proceed with the 
installation. 

Please select the path where you would 
like to install the files for BURY Time Suite. 
If you're unsure, simply select the suggest-
ed destination folder Please pay attention 
to the data on available storage space for 
the software and the amount of free space 
on your computer or laptop. Depending on 
the number of BURY Time Suite users 
(single user / multiple users / amount of 
map data), the database with recorded 
trips may require several megabytes of 
free disk space. Please ensure that 
sufficient free resources are available. 

After clicking the “Install” button, the 
installation process will begin, and the data 
will be transferred to the hard drive. 
Depending on your computer or laptop’s 
hardware, this may take 1–2 minutes. You 
can monitor the installation progress on 
the green status bar. 
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i
 � The installation process can be 

stopped at any time. Any files already 
installed will then be removed. 

After transferring the larger program files, 
the wizard will ask if you would like to create 
a shortcut to the program on the desktop. 
If so, a shortcut icon will be created on your 
computer's desktop. By double-clicking this 
icon, you can open the BURY Time Suite 
program. Otherwise, please click “Start,” 
then “All Programs,” and look for the entry 
named “BURY Time Suite.” 

In the BURY Time Suite program, it is 
necessary to fill in certain data for some 
routes. The required fields vary depending 
on the country. Please select the country or 
legal basis according to which the vehicle 
logbook should be created. 

i
 � If you file your tax return in   

a country other than the Netherlands  
or Germany, please select the “Other 
Europe“ option. You may also select 
“Private” (without required fields or 
tour log verification). 

Please now click “Finish” to complete the 
installation. You can now launch the BURY 
Time Suite program. 
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4. FIRST USE OF THE 
BURY TIME SUITE 
PROGRAM 

When you open the BURY Time Suite 
program for the first time, you need to 
designate an administrator and properly 
enter usernames and passwords. 

If you are using the program privately, 
then you only manage your own data. 
However, if the software is used on 
a network and multiple people will be 
working with it, it is important to agree 
on role assignments in advance (Who will 
be the administrator?). You can find 
additional information on this topic in the 
following sections. 

In the first User details window, please 
enter the password It can be alphanumeric 
and include special characters. Be mindful 
of uppercase and lowercase letters and 
accuracy when entering the password. 
The password is displayed as asterisks while 
typing, making it easy to make an error 
during entry. Therefore, please enter the 
password a second time. The entered data 
will be compared. If they match, you can 
select “Save” to complete the process. 

i
 � The remaining user information 

can also be entered later in the 
program. 

 � BURY Time Suite does not allow 
the administrator to reset the pass-
word. Therefore, the password should 
be stored securely, for example,  
in a Password Manager. 

The Login screen for BURY Time Suite will 
now appear. Please re-enter the password 
here and select the menu language you 
wish to use in BURY Time Suite. After 
clicking “OK,” the program will start. 
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5. SOFTWARE UPDATE INSTALLATION 

After extended use of the software, please check bury.com for a new update for your 
product if automatic notifications have been disabled. Note the version number displayed 
when the software starts, and verify if a new update is available for that version. 

For example, if version 3.0 is displayed, you will find several updates with version 
numbers 3.1, etc., on the bury.com website. Please download and install the updates, 
starting with version 3.1, followed by 3.2, and so on. 

If no detailed maps are installed (i.e., if the 
user downloaded the software and is 
opening it for the first time), a message will 
appear: “Map data found. Please select at 
least one country from the list. The map 

data will be downloaded and installed.” 
(Map material — see page 29).
 

 � Using the “Cleaning and Perfor-
mance Tools” software to clean out 
old data and unused settings in the 
Windows registry database may 
prevent BURY Time Suite from 
launching. In such a case, it will be 
necessary to reinstall the Suite. 
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 � It is not possible to update directly 
from version 3.0 to version 3.2!  

After completing the update, your BURY 
Time Suite software will be up-to-date 
again. You can check the new features in 
the updates in the “Release Notes.” 

You can update the software automatical-
ly by selecting File -> Settings and 
checking Check for updates. 

If an update is available, click on the 
notification in the toolbar. A window with 
information about the current update 
version will open. By pressing OK/
Update, the update will be downloaded 
and installed. 

The update will be downloaded and 
installed. Please wait… 

By pressing “No/Cancel”, you will return 
to the main menu. 
 

 � If you are using BURY Time Suite 
on a network, you should first update 
the installation on the server. 

The update installation completed success-
fully. BURY Time Suite will restart / The 
update installation failed. Please try again. 

After installing the update, restart your 
computer. 

If a new update is available, a notification 
window will appear each time BURY Time 
Suite starts, allowing you to perform the 
update directly from this window. 

6. USING THE SOFT-
WARE IN A NETWORK 
ENVIRONMENT WITH 
MULTIPLE USERS 

Background: 
Your company has several company 
vehicles, some of which employees may use 
for both business and private purposes. 
These vehicles are equipped with the BURY 
electronic vehicle tracking system. Manage-
ment and storage of recorded location data 
for all vehicles should be centralized in 
a database. Employees should work locally 
at their workstations using the BURY Time 
Suite program to create their individual 
vehicle logs. 

Step 1: 
Please appoint an administrator or contact 
person within your company who will be 
responsible for setting up and managing 
users, vehicles, and drivers in the BURY 
Time Suite program. Depending on the 
structure and size of the company, this 
employee may also be assigned other tasks, 
such as reading vehicle location data if this 
task is not performed by individual 
employees.

Step 2: 
Please install BURY Time Suite on a server 
that will later be accessible to all employees 
who will work with the program. Note the 
path (IP address / drive letters and directo-
ry names) to the directory where the 
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GPSLOGGERDATABASE.FDB. database is 
located. This file stores user management 
data and position data. 

Step 3: 
To add additional program users, go to 
Own data -> Program users. Click the 
green “+” symbol to create a new data 
record. You can create up to 1,000 
additional users for concurrent access 
to BURY Time Suite. 
 

A User details data entry window will 
appear. First, enter the username. Choose 
a name that is as clear and unique as possible, 
ideally following any internal naming 
conventions your company may have. 

Next, enter any remaining details if you 
wish to include additional employee data. 
You can also add an employee photo by 
clicking on the photo field. 

Required fields are outlined in red. These 
must be completed to create a data record.  
Set a password for the user, then click Save 
to create the record. The new user will 
appear below the administrator entry creat-
ed during the initial setup of the manage-
ment software. Repeat step 3 until all users 
have been created. 

Step 4: 
Please also install the program on the 
computers of employees who will work 
with BURY Time Suite in the future. 
Launch BURY Time Suite and enter the 
administrator password here as well. 
This password is entirely independent 
of the password used during the server 
installation. For security reasons, it should 
be different. For subsequent installations, 
you may use this new password. 

Typically, it won’t be needed later since 
users will connect to the server database 
rather than a local one. 

Once the user interface appears, click 
File in the upper left corner, then Settings. 
In the opened window, enter the server 
IP address and the saved database path. 

Click Test Connection to verify the en-
tered data and check access. A message 
will confirm the connection. If the data is 
correct, click Save. BURY Time Suite will 
then close. 

Employees can now log in using only the 
usernames and passwords previously set 
up in the server installation. Network 
setup is complete.

é
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 � Users can no longer log in with 
administrator privileges unless you 
have assigned such privileges to their 
user accounts. 

If a user activates their local database, 
they will not be able to log in after closing 
the software, as they do not know the 
(secondary) administrator password, and 
no additional users were created in their 
local database. Only the administrator can 
reset the correct database.  

7. OVERVIEW 
OF MENU ITEMS 

The BURY Time Suite program has three 
main areas: Logbook, Own data, and 
Configuration. These areas and their 
auxiliary functions can be accessed through 
the menu bars.  

Menu Items in the Logbook area 
In Processing routes, you can enter missing 
data related to tours. 

By selecting View map, you can open a map 
of European country borders and zoom in 
on a selected area using the mouse scroll 
wheel or by pressing “+” or “-” on the zoom 
bar on the left side of the map. 

The Driver's logbook allows you to search 
for saved routes, present them in various 
ways, and print them. 

Menu Items in the Own data area 
If you are registered as an administrator, 
you can add additional users in Program 
users. Double-click an existing entry to edit 
it, or click “+” to add other users. A window 
will open for entering user data. Remember 
to assign privileges. If you use the manage-
ment program without admin rights, this 
menu function will not be visible. 
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If you frequently visit the same location, 
you can enter data for people or compa-
nies visited in Destinations/Contacts. 
These entries can be assigned to routes or 
automatically recognized and added during 
file import. 

If you use more than one vehicle, you can 
list and manage them in the Cars submenu. 

If several drivers use one vehicle (e.g., in 
a family or fleet), you can manage them 
through Drivers management. Drivers are 
not program users and cannot manage 
their own routes. 

You can create different travel destinations 
in Journey reasons. This is useful for 
regular routes, like client visits, service 
visits, or commuting. 

Menu Items in the Configuration area 
The range of functions available in this 
menu depends on several factors. 
The Restore database, Backup database 
Reset database, and Delete all tours from 
database submenus are only available if you 
have administrator rights. Data can be 
saved on a separate drive and reloaded in 
case of data loss. 

Other menu items are usable if the 
CL 1020 Time is connected to the 
computer via a USB cable. 

In Hardware configuration, you can set the 
Default type of journey, which will be 
automatically applied when the vehicle 
starts (ignition/engine on).   

The Danger zones menu allows you to load 
a file containing over 25,000 danger zones 
across Europe into the BURY product. 

If this file is saved in the BURY product, 
a warning for zones with speed limits will 
activate automatically if the speed limit 
warning function is enabled. 

i
 � The danger zones that are included 

are provided by the third party com-
pany Eifrig Media. You can download 
updates to this data against payment 
at the internet site www.scdb.info. 

Using the Firmware update menu item, 
you can update the connected BURY 
system. 

Additional Menu Items 
Two more options, File and Help, are 
located on the top menu bar. 

In Settings within the File menu, you can 
specify an alternative path for your 
database, which is useful if the database 
is saved on a different drive or if multiple 
users should access only one database.   
Here, you can also decide whether 
distances are displayed in kilometers or 
miles. You can close the BURY Time Suite 
program by selecting Exit and confirming 
safety. 

In the Help menu, you can find contact 
information and the manufacturer's phone 
number for any inquiries. 
Open BURY Time Suite manual 
This section provides access to the 
program's user manual. 
Manufacturer’s declaration 
Here you can view the Declaration of 
Conformity. 
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8. ADDING  
ADDITIONAL DRIVERS

Each program user is automatically 
registered as a driver in the driver manage-
ment system. However, if a different driver 
(who is not a program user) drives the 
vehicle, they must be separately registered 
in the driver management system. 

Examples: 
Private Use: You also use the vehicle for 
personal purposes, and a family member 
drives it. 

Business Use: A colleague who does not 
have a company vehicle drives your car. 
  
Each program user can add additional 
drivers. In network mode, it is recommend-
ed to hide private drivers so they are not 
visible to all users. 

To add a new driver, go to Own data / 
Drivers and click the green “+” symbol. 
In the opened window, enter the driver’s 
details, consisting of a driver ID and the 
employee’s first and last name. The only 
mandatory field is the Surname field.  
The driver ID can be alphanumeric and up 
to 20 characters. 

For business purposes, you might use 
personal numbers, and driver IDs should 
be logically constructed for easier tracking. 
After saving the data, the new driver will 
appear in the list. 

i
 � You can also delete a driver if 

there are no tours assigned to their 
account. 

9. ADDING VEHICLES

Before adding one or more vehicles, 
prepare the vehicle documents (registra-
tion certificate, vehicle card) and record 
the vehicle's mileage. 

In the Own data menu, open the vehicle 
management system by selecting the Cars 
icon. Add a new vehicle by clicking the 
green “+” symbol. In the open window, 
complete the mandatory fields marked in 
red: Licence, Start mileage, From date, 
User, and default Driver. 

The odometer reading should match the 
value displayed in the vehicle at the time 
of installing the electronic driving log 
system. Please select yourself or another 
user as the owner who may use the 
vehicle for private purposes. If there are 
no other drivers, the user will also be 
entered as the default driver. 
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After saving the information, the vehicle will appear on the list. 

If multiple vehicles are added and you want to display them by category later, click once on 
the desired category: Number (Licence) plate, Vehicle manufacturer, or Vehicle type. The 
list will be displayed in ascending or descending order.
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For example, if the entered contact is your 
employer’s address, you can set a standard 
journey reason like “Office visit”. 
This travel purpose will automatically be 
assigned for all tours ending at this address 
without the need for manual entry. 

After entering the contact partner’s details, 
click the blue Apply contact partner field.  
The contact will appear on the list. You can 
add another contact partner (multiple are 
possible) by following the same steps. 
After adding all contacts, click Save. 

10. ADDING DESTI-
NATIONS / CONTACTS 

You can save frequent destinations/contacts, 
such as your home address, employer’s 
address, office, and frequently visited clients, 
to avoid re-entering them each time you travel. 

Adding/Modifying contacts 
Click the “+” symbol to add a new contact. 
The Details window will open, showing the 
Address data and Map tabs. Based on 
address data, complete the mandatory fields, 
which vary by country: Name/Company, 
Street, City, Standard journey reason, and 
Contact partner — First name and Surname. 
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Since these coordinates may not always 
be found by your vehicle, you should 
create a target area around the specified 
position. To do this, click Change target 
area above the map, which will be 
highlighted in blue. 

Hold down the left mouse button and 
draw a large area around the marked 
position. Later, when you enter this area, 
the saved address will be assigned to it. 
This is useful if you need to park a few 
meters outside this area, e.g., due to 
parking or construction work. It’s also 
helpful for larger contact addresses, like 
a large business site. 

Click Apply. If there are already address 
details, a warning will appear indicating 
that these details will be overwritten. 

i
 � If Apply is not clicked, the address 

data from the selected position on 
the map will not be saved. 

A green check mark  in the Complete 
Contact field will confirm the complete-
ness of the data. 

Entering coordinates using the Map 
Your BURY product in the vehicle records 
GPS coordinates. These coordinates, or 
locations, can be visually represented on 
maps in BURY Time Suite. To display 
a saved or imported contact (address) 
and assign it correctly to a travel type, 
assign the appropriate coordinates in the 
Map tab. Left-click on the map to place 
a marker (yellow pin) at a position. 

Since it's difficult to pinpoint an exact 
address on the general view, zoom in on 
the map. Use the scale slider in the upper 
left corner or the mouse scroll wheel to 
zoom in/out. 

Zoom in on the area containing the 
contact address. Once the map is suffi-
ciently zoomed, you can place the pin in 
the exact spot. 
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After successfully transferring address 
information from the Map tab to the 
Address data tab, press Save. 

A similar feature can be found in Log-
book under View map. During trip 
processing, you can use addresses as 
templates.  

11. ADDING 
JOURNEY REASONS

If multiple drivers use the device, it is 
recommended to set up a defined 
Journey reasons visible to all users. 
This way, all users can name specific 
tours with the same initial letter, making 
the vehicle log more organized and easier 
to read. The vehicle log will become more 
transparent. 

12. BACKUP / RESTORE 
THE DATABASE 

After completing all basic settings, it is 
recommended to create a backup of the 
database before importing the first data. 
Thus, during the initial phase, when test 
data is being loaded, you can safely try 
out all the functions. 

i
 � The ability to create a backup and 

restore the database is available only 
to users with administrator privileges.               

Please open the Configuration menu 
and click on Backup database. A new 
window with a wizard will open to guide 
you through the steps. The extension of 
your backup file is *.fbk, and the file 
name consists of the current date and 
time in the following format: backup_
YYYYMMDDHHMMSS. 

If you wish to restore the saved data, 
a separate window with a wizard will also 
launch. To do so, please click on Restore 
database and follow the instructions. 
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13. IMPORTING 
POSITION DATA 

i
 � Ensure that the map data for the 

routes you want to import is installed. 
Otherwise, the starting position or 
destination address cannot be found.

 � Importing data for multiple tours 
may take a few seconds. During the 
import process, do not unplug the 
USB cable from the computer or 
device. 

 � The Import data button can only 
be clicked after entering the odome-
ter reading and ensuring it is greater 
than the previous reading. 

 � If you accidentally click Skip 
import, you can click Devices on the 
toolbar in the bottom right corner. 
You can now select the connected 
system again. The Data import 
window will reappear. 

 � Once the position data has been 
imported, it cannot be imported 
again. A corresponding message will 
appear during the import attempt.

i
 � Database backups should be 

performed at regular intervals.  
If possible, the backup should be 
created on a separate storage device. 

 � A backup is automatically created 
before each import of new data. You 
can disable this function in the import 
window by unchecking the box labeled  
Backup database before import. 

Reset database 
The database will be reset. All previous-
ly entered and imported data will be 
permanently lost! BURY Time Suite must 
be restarted. 

Delete all toures from database 
All recorded routes of all users will be 
permanently deleted from the database! 
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Please proceed as follows: 

1) Remove the CL 1020 Time device from 
the vehicle and note the odometer 
reading. 

2) Launch BURY Time Suite on your 
computer. 

3) Connect the CL 1020 Time device to 
the computer using a USB cable. 

The automatic data import will start. 
4) Select the user if multiple users have 

been previously created. 
5) Select the vehicle if multiple vehicles 

have been previously added, or create 
a new vehicle. 

6) Select the driver if multiple drivers have 
been previously added, or create a new 
driver. 

7) Enter the current odometer reading 
of the vehicle. 

8) Now, click Data import.  

Please enter the vehicle's odometer 
reading without decimal places. Appro-
priate rounding should be applied. 
After a prompt asking if this value is 
indeed correct, the BURY Time Suite 
program will calculate whether the 
entered value matches the recorded 
kilometers of the tour stored in the BURY 
Time device. 

In the given example, 695 km were recorded in the Time device, while the entered value 
is 825 km. 

Click “Yes” to confirm the excessively high value, and a deviation will be generated to 
account for the missing kilometers. 

By clicking “No,” you will return to the data import window, where you can re-enter the 
kilometers. 
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Differences between the vehicle's odometer readings and the electronic vehicle log 
can be significantly larger and may arise from various reasons: 

a) Example of a higher odometer reading in the vehicle: 
The electronic vehicle log was not connected during the tour or was malfunctioning. 

What happens in BURY Time Suite? 
A deviation will be generated to compensate for the missing kilometers. This will allow you 
to log or complete additional tours until the deviation kilometers are fully accounted for. 

In the given example, a deviation of 80.16% is far too large. 

After subsequently entering the tour not recorded by the device (marked in gray), 
the deviation rate was significantly reduced to 8.73%. However, it must not exceed 7% 
if you wish to finalize the tours and create a vehicle logbook. In the deviation field, there 
are still 48.2 km available for further completed tours. 
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b) Example of a higher odometer reading 
in the electronic vehicle log: 
Typically, such a case should not occur. 
Exceptions include situations where the 
vehicle is transported by ferry, train, 
or trailer, and the electronic vehicle log 
was active. 

 � In the situations mentioned above, 
the electronic vehicle log should be 
deactivated by turning off the vehicle's 
engine or ignition, or by removing the 
device from its holder or unplugging it 
from the USB port. 

What happens in BURY Time Suite? 
Please enter an odometer reading that is 
significantly lower than the recorded 
mileage in the BURY Time device. This 
will result in your tours being logged 
with a small negative deviation, allowing 
you to create the vehicle logbook 
without any issues. 

If the entered value significantly differs 
from the mileage recorded on the device, 
a corresponding message will be displayed. 
If data import continues, it may result in 
all tours being assigned a very high devia-
tion rate, potentially making it impossible 
to display the traveled kilometers 
accurately. Such a vehicle logbook would 
be practically useless.  

Delete last import is a function located 
in the More dropdown menu under 
Processing routes. It allows you to delete 
the most recently imported tours. 

 � Only the user's and vehicle's 
unfinished tours will be deleted. 
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14. PROCESSING POSITION DATA 

If the position data import is successful, the Data import window will close. The data will 
now be compared with the map material stored in BURY Time Suite and processed into 
precise address data. However, it may happen that certain positions are not recognized. 
In such cases, they must be completed manually. Please open the Logbook menu, then click 
on Processing routes to begin processing the tours.  

The following data will be presented in tabular form:  

Tour type
There are four types of tours: business 
(green), commute to/from work (yellow), 
private (red), and deviation (brown). 

Data complete
Indicates whether all mandatory fields are 
filled and whether the trip can be finalized. 

Licence
Vehicles can be distinguished based on 
their registration numbers. 
Joined
If two or more tours are combined, 
a checkmark is used as the indicator. 
These tours can then be separated again. 

Start date 
This field displays the date and time when 
the tour began. 
 
Name/Company (Start)
Last name or company name — the starting 
location of the tour. 

Start Address 
This field displays the address at the start 
of the tour. The destination address is 
used as the start address for the next tour 
if it has no address and the geographic 
point is the same. 

Start km / Start miles (Eng.) — 
this depends on the selection made in the 
Settings menu. The odometer reading at 
the start of the tour. 

End date 
This field displays the date and time when 
the tour ended. 

Name/Company (End)
Last name or company name — the end 
destination of the tour. 

Destination 
This field displays the address (excluding 
house numbers) at the end of the tour. 
End km / End miles — this depends on the 
selection made in the Settings menu. 
The odometer reading at the end of the tour. 



20

CREATING A DRIVER’S LOGBOOK

End km / End miles (Eng.) — 
this depends on the selection made in the 
Settings menu. The odometer reading at 
the end of the tour. 

Tour distance 
The number of kilometers traveled. 

Deviation 
The current deviation rate for the tour. 

Duration 
Indicates the driving time in hours, minutes, 
and seconds. 

Editing date
The date the data was imported from the 
device into BURY Time Suite or the tour 
record was modified. 

Above and below the table, there are 
several menu options and filter settings.

Above the table:  

Refresh view 
Reloads the view 

Show tour
After selecting a tour (row), you can 
display the tour on the map. You can 
zoom in or out and determine the amount 
of position data presented (blue arrow). 
Using the Left Arrow or Right Arrow 
buttons, you can navigate to the previous 
or subsequent tour. 

i
 � On the map, in addition to the 

blue arrows, hooked arrows in red 
and green may also appear if the  
CL 1020 Time device was removed 
from the hanger and then reattached 
during the ride. This event is record-
ed only if the device is permanently 
installed in the vehicle using the  
AC 5140 connection box.  

Close tours
After processing, tours can be finalized 
and moved to the official Driver’s logbook.  
Once this action is completed, data 
processing can no longer be performed. 
To finalize a tour the data must be 
complete (indicated by a green checkmark 
in the Data complete column), and the 
deviation must not exceed 7%. 
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Tourtype
Here, you can choose to display tours based 
on the four tour types. Multiple types can 
also be selected simultaneously. 

Period of time(Time Range) 
Here, you can specify the time range for 
which tours should be displayed. 

Car 
Here, you can sort the table by vehicles for 
which tours have already been recorded. 

By double-clicking, you can open and 
process a tour. Exceptions are deviations, 
which are created automatically. In the 
Tour details window, you can complete 
the mandatory fields for the start and 
destination addresses if they are still empty. 

The Tour details window contains the 
following fields: Tour distance, Tour type, 
Driver, Contact person, Journey reason, 
Description. 

If a deviation is generated during data 
import due to mileage differences, you 
can allocate the kilometers listed there to 
this or another tour in the Distance field 
until the deviation value is 0.0 or 0.1 km. 
The field will be inactive if no deviation 
has been created. 

Connect tours
Connecting tours can be useful, for 
instance, when you were on a business tour 
that included multiple breaks. Only green 
(business) and yellow (commute) tour types 
can be combined; combining other types is 
not possible. To select multiple rows, hold 
down the Shift key and select the rows 
using the mouse or arrow keys. 

Add tour 
If a deviation with a positive odometer 
reading is generated, you can manually add 
the missing tours. This reduces the 
deviation rate for all tours in this view for 
the selected vehicle.
 
More  

 Print view 
If you wish to print a preview of the 
tours, you can use this function. 
A separate window will open, display-
ing the print preview for the tour list 
along with additional options. Such a 
printout is not intended for official use 
— it is not a vehicle logbook. 

Delete last import 
Only the unfinished tours of the user 
and vehicle will be deleted. 

Export 
Export Data to Excel File.
 

Below the table:   

User 
Here, you can select either all users or 
just the administrator. Depending on the 
selection, tours for all users or only the 
administrator's tours will be displayed. 
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CREATING A DRIVER’S LOGBOOK

You can also change the type of tour and 
the driver. Additionally, you can enter a 
contact person, journey reason (if previous-
ly created), and a description of the tour. 
 
If the Tour type field indicates a business 
tour, the Contact person and Journey 
reason fields must be completed.  

Alternatively, you can provide additional 
information for this type of tour in the 
Description field, such as details about 
passengers or post-accident damages. 
Using the Show tour button, you can 
display the tour on the map. Click Save to 
apply the entered data.  

i
 � If changes are made to existing 

tour data, they will be logged. In the 
printed driver’s logbook, old data is 
crossed out but still visible. 

 � If business tours are changed to 
private tours or commute tours, such 
changes will also be logged. 

 � Select the Private tour type in the 
BURY Time device to ensure that no 
address data is recorded, which could 
later be imported or sent to the 
driver’s logbook. 

15. CLOSING TOURS 

i
 � If you file your tax return in 

Germany, we recommend completing 
your tours within 7 days to demon-
strate timely maintenance of the 
vehicle logbook to the tax office.

To close tours, all starting and destination 
addresses must be present, and the 
deviation rate must not exceed 7%. 
Similarly, all mandatory fields must be 
completed. The “Data complete” column 
indicates whether a tour can be finalized 
(green) or requires editing (red).  

i
 � The deviation rate is calculated 

based on the odometer readings you 
provide for the vehicle and the kilome-
ters recorded in the electronic vehicle 
log. The deviation rate is evenly 
distributed across all unfinished tours 
during the import process. 

 � Tours with uneven deviation rates 
cannot be combined. 
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In the example below, all tours from September 27, 2024, were processed. To finalize 
the day and its tours, select the last tour with the same date. After clicking “Close tours”, 
a safety confirmation window will appear. Upon confirming, the tours from September 
27 will be finalized and moved to the driver’s logbook. 

16. PRINTING THE DRIVER’S LOGBOOK

The driver’s logbook contains finalized tours assigned to a specific vehicle (registration 
number). By clicking the “+” symbols, additional details will be displayed. Select the 
desired period for the driver’s logbook (highlighted in blue) and click the printer icon 
to print it. 

Before printing the Travel Log, you will be prompted to fill in several fields regarding the 
start and end date of the log, as well as the vehicle's odometer reading at the beginning 
and end of the recording period.
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CREATING A DRIVER’S LOGBOOK

The example shows a condensed version of the vehicle logbook.

If incorrect data is entered, such as the 
start date of the log being later than the 
end date, the fields requiring correction 
will be highlighted with a red border.

If these data are not entered in the 
displayed window and the "OK" button is 
pressed, they must be completed manually 
after printing. 

The accuracy of the driver’s logbook must 
be confirmed with a signature after printing. 



25

17. REMOVING OLD VEHICLES 

Many customers use BURY Time Suite for several years, during which a significant 
amount of data, such as old or unused vehicles, can accumulate. When starting the 
BURY Time Suite program, loading these old logs takes a long time and unnecessarily 
slows down the computer or program. 

To remove unnecessary data from BURY Time Suite, first print a backup copy of the 
finalized vehicle logbooks you wish to archive. This ensures the data is preserved. 
Then follow these steps: Go to Own data -> Cars. Select the registration number of the 
vehicle you wish to remove (highlighted in gray). Click on the red “-” symbol. Confirm by 
clicking “Yes”. The data for this vehicle and its vehicle logbook will be deleted. 
 



26

CREATING A DRIVER’S LOGBOOK

18. DEVICE REPLACEMENT 

If the vehicle log device becomes damaged and can no longer be used, it must be 
replaced with a new one. To do this: 1) Remove the old device from the vehicle and note 
the odometer reading. 2) Connect the new device in the vehicle.  

To remove the old device from BURY Time Suite: 1) Launch BURY Time Suite on your 
computer. 2) Go to Own data and select Cars. 3) Highlight the registration number of the 
vehicle where the device was replaced. 4) Double-click on the blue bar. 

In the opened window: 1) Click the “-” 
symbol located to the right of the device's 
serial number. 3) Select “Yes” and then 
click “Save”. 
 
After saving the changes, the serial 
number of the removed device will no 
longer be visible. All other data related to 
the vehicle will remain unchanged.   

i
 � Currently imported data for this 

vehicle will not be lost. With the next 
import, new data can be assigned to 
this vehicle. 
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Importing data from the new device  
To do this, please:  
1) Remove the new device with the saved 

data from the vehicle and note the 
odometer reading. 

2) Connect the device to the computer 
using a USB cable. The data import will 
start automatically.

i
 � In the open import window, you 

will see the data (inactive) for the 
user and vehicle, as well as the 
previous odometer reading entered 
during the last data import and the 
date of the last tour. 

3) Select the driver if multiple drivers have 
been previously added, or create a new 
driver.

4) Enter the current odometer reading of 
the vehicle. 

5) Now, click Data import. 

 � Once the position data has been 
imported, it cannot be imported again. 
A corresponding message will appear 
during the import attempt.

In the vehicle list, the serial number of the 
new device will be displayed next to the 
registration number of the vehicle where 
the device was replaced. 
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PRODUCT CONFIGURATION

19. MENU 
CONFIGURATION 

In addition to the previously described 
Backup database and Restore database 
options, the Configuration section 
contains additional menu items:  

Device configuration 
Device Access: This menu option allows 
you to select and access a connected 
device. In the displayed details, under 
FW version, you can check the firmware 
version installed on the device. 

Buzzer volume: Every CL 1020 Time 
device is equipped with a buzzer. In the 
Volume level submenu, you can adjust the 
buzzer's intensity.    

Default trip type: You can select the type 
of trip that will be active when CL 1020 
Time is started: Private, Commute to/from 
Work, Business, or Last used mode. 
You can also configure a Permanent or 
One-Time Travel Type Notification. 
For one-time notifications, the LEDs will 
turn off after about 10 seconds. The LEDs 
will light up again only after changing the 
trip type or restarting the vehicle. 
The notification duration can be extended 
to a maximum of 60 seconds.  

GPS signal notification: If you wish to be 
informed about GPS signal reception at 
the start of a trip, activate the appropriate 
notification by clicking on GPS signal Found 
notification. You can also set a time interval 
for receiving notifications if there is no GPS 
signal reception.    

Speed limit zones notification: Once 
the speed limit warning function is 
enabled and installed, the buzzer will 
signal such zones as you approach them. 
The signal can also be deactivated or its 
tone changed. 

The final position shows whether speed 
limit zones are installed on the device and, 
if so, the installation date.  

Danger zones (Speed Limits)
Clicking this menu item opens a separate 
window with a wizard that guides you 
through the steps.  

 � You must strictly adhere to the 
traffic regulations and legal provisions 
of the country in which you intend to 
use this function. 

Firmware update 
At irregular intervals, you will receive 
information about CL 1020 Time updates 
available on the website: bury.com/en/
products/cl-1020-time/.... The download 
files are available under the product 
description. 
It is recommended to load the already 
saved data and perform the update to 
take advantage of the new features. 
If you have any additional questions on 
this topic, please contact our service team. 
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Map material

 � Before importing tours/routes 
from the device, the appropriate map 
material for the country where the 
tours took place must be installed. 
Otherwise, the starting and destina-
tion addresses of the imported routes 
cannot be found, and the address 
fields will remain empty. 

i
 � If possible, install only the maps 

of countries you actually need. 
Otherwise, the performance on 
computers with low memory may 
decrease. 

To display the list of available countries, 
an Internet connection is necessary.  
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PRODUCT CONFIGURATION

The “Installed” checkbox indicates whether a map for a specific country is already 
installed. 

The size of the downloaded file shows the compressed size of the map file, which 
represents the amount of data to be downloaded.   
 

If a map update is available, an “Update” button will be provided. In this case: 1) Press 
the Update button for the installed map. 2) You will be asked if you also want to update 
all other installed maps. 3) Press Accept to download and install the new maps.  

To uninstall a map: Uncheck the “Installed” checkbox for the specific country. Press the 
“Accept” button. 
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19.1 FACTORY SETTINGS 

 � You can restore the device to 
factory settings when the EPP data 
has been read and in the case of 
installing the system in another 
vehicle. 

 � During the reset process, do not 
unplug the USB cable from the 
computer or the device. 

If you wish to use CL 1020 Time in a differ-
ent vehicle or assign it to another user, you 
must restore the device to factory settings. 
If the device is to be resold, this process 
must also be performed.  

Select “Devices” on the bottom right of 
the open window, then click “Factory reset”.  

From the expanded “Device” list, 
select the appropriate device and click  
“Reset device”.  

Confirm two safety prompts by clicking 
“Yes”. This will erase all position data 
from the product. Depending on the 
amount of data, this may take a few 
seconds. Once the process is complete, 
a message will appear: “Device success-
fully reset”. Click “OK” to close the 
message. The “Data import” window will 
appear and will close automatically after 
disconnecting the device from the 
computer. 

If a new user uses CL 1020 Time with 
the same BURY Time Suite, the serial 
number of the device must be unlinked 
from the existing vehicle in the vehicle 
management system. 
To do this: Click on the relevant vehicle 
and open the Vehicle details. Click the “-” 
button to delete the association. 
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FURTHER INFORMATION

20. SERVICE 

In case of general or technical queries, 
suggestions and comments, please do 
not hesitate to contact our team at any 
time. Suggestions and feedback are 
always welcome: 

Administration:
BURY GmbH & Co. KG
Robert-Koch-Straße 1-7
D-32584 Löhne 
GERMANY

Hotline: +49 5732 9706 2112
E-mail: hotline@bury.com

Producer: 
BURY Sp. z o.o. 
Wojska Polskiego 4 
39-300 Mielec 
POLAND
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